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Pertama-tama saya ucapkan puji dan syukur kehadirat yang 

Maha kuasa atas anugerah dan karuniaNya selama ini, sehingga penulis 

dapat menyelesaikan buku perdana sesuai dengan apa yang penulis 

harapkan. Setiap hasil penelitian yang baik, maka perlu manajemen data 

yang baik pula, software yang dapat membantu dalam melakukan 

manajemen data yaitu dengan menggunakan Statistical Product and Servicer 

Solutions atau lebih dikenal dengan sebutan “SPSS” merupakan program 

yang dapat membantu seorang Dosen, Peneliti dan Mahasiswa dalam 

pengolahan dan analisis data penelitian. Tidak sedikit dari kalangan dosen 

maupun mahasiswa yang mengalami kesulitan dalam melakukan 

menajemen data, bingung dalam mengolah data yang telah didapatkan, 

baik berupa data primer maupun data sekunder. Oleh sebab itu buku ini 

hadir dalam rangka memberikan pemahaman secara dasar mengenai 

manajemen data, manajemen data ini merupakan tahapan dasar untuk 

melakukan uji statistik selanjutnya. Buku yang berjudul “Manajemen 

Data menggunakan SPSS” merupakan buku panduan bagi Dosen, 

Peneliti maupun Mahasiswa yang berisi mengenai Persiapan Data, 

Mengorganisasikan Data, Transformasi Data, Analisis Univariat, Uji 

Instrumen, Uji Normalitas, Homogenitas dan Linieritas. Penulis 

berusaha semaksimal mungkin untuk dapat memberikan tatacara dalam 

manajemen data sesederhana mungkin, agar dapat dipahami dari semua 

kalangan serta penulis juga sangat menyadari bahwa buku ini jauh 

daripada kesempurnaan dan banyak kekurangan dari segi materi 

pembahasan, sistematika penulisan dan tata bahasa, tiada gading yang tak 

retak, maka oleh sebab itu penulis sangat mengharapkan kritik dan saran 

yang konstruktif demi perbaikan penyempurnaan buku ini di masa yang 

akan datang. Akhir kata saya ucapkan terimakasih yang luar biasa kepada 

Publikasi dan Pengelolaan Jurnal (PPJ) Universitas Islam Kalimantan 
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Muhammad Arsyad Al Banjari Banjarmasin yang turut membantu dalam 

penyelesaian buku ini dan semoga buku kecil ini dapat memberikan 

manfaat bagi para dosen, peneliti maupun mahasiswa untuk dapat 

melakukan manajemen data dengan baik menggunakan SPSS. 
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ata statistic sebenarnya berasal dari bahasa latin, yakni 

status yang berarti Negara. Pada perkembangan awalnya 

statistiK diartikan sebagai keterangan-keterangan yang 

dibutuhkan oleh Negara dan berguna bagi Negara itu sendiri. Dalam 

pengertian ini statistik hanya diartikan sangat terbatas yaitu 

sekumpulan data atau angka mengenai kondisi penduduk, sedangkan 

menurut Croxton dan Cowden seorang ilmuwan yang merupakan 

sesepuh dalam dunia statistic mengatakan bahwa pada dasarnya 

statistic merupakan metode untuk mengumpulkan, mengolah dan 

juga menyajikan serta menginterpretasikan data yang berwujud angka 

(Wahyono, 2012).  

Menurut Sutrisno Hadi, ahli statistic di Indonesia 

mengatakan bahwa dalam batasan khusus statistic digunakan untuk 

menunjuk angka-angka pencatatan dari suatu kejadian atau kasus 

tertentu. Mengingat begitu pentingnya  statistic, teknik pengolahan 

datanya pun berkembang terus dari waktu ke waktu. Mulai dari 

pengolahan secara manual yang memakan waktu sangat lama, sampai 

pada pemrosesan dengan memanfaatka alat bantu computer 

(Wahyono, 2012). 

SPSS kependekan dari Statistical Product and Service Solution, 

merupakan program untuk membantu dalam melakukan olah data 

dan analisis data statistic. SPSS dipublikasikan oleh SPSS Inc dan 

untuk saat ini sudah diakui oleh perusahaan IBM. SPSS versi pertama 

dirilis tahun 1968, diciptakan  oleh Norman Nie seorang lulusan 

fakultas ilmu politik dari Stanford University. Program ini dapat 

digunakan berbagai keperluan seperti olah data pada tugas akhir, 

skripsi, tesis atau penelitian-penelitian lainnya (Priyatno, 2011). 

 

K 
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A. Pengenalan Windows SPSS 

Jendela ini terbuka secara otomatis setiap kali program SPSS 

dimulai dan berfungsi untuk input data SPSS. Menu yang ada 

pada editor adalah : 

1. File 

Untuk menangani hal-hal yang berhubungan dengan file data, 

seperti membuat file baru, membuka file yang lama, 

mengambil data dari prigram lain, menyimpan data, 

mengecek isi data, print, dan keluar dari program. 

2. Edit 

Untuk melakukan pengeditan seperti Undo, Redo, Cut, 

Copy, Clear dan Insert Variabel. 

3. View 

Untuk mengatur toolbar seperti status bar, font, value label, 

variabels dan lain-lain. 

4. Data 

Untuk keperluan yang berhubungan dengan data seperti 

mengurutkan data, validasi data, menggabungkan data, 

membagi data. 

5. Transform 

Untuk membuat perubahan pada variabel yang telah terpilih 

berdasarkan kriteria tertentu seperti compute variabel, rank 

cases, automatic recode. 

6. Analyze 

Merupakan menu pokok untuk analisis data seperti analisis 

deskriptif, analisis bivariate parametric dan bivariate non 

parametik 

7. Graphs 

Untuk membuat berbagai grafik, seperti Bar, Dot, Line, Pie, 

Histogram dan Scatter 

8. Utilities 



3 
 

Mengatur tampilan menu seperti  data file, comment, Run 

Script, Production Job dan lain-lain. 

9. Add-Ons 

Untuk membuka aplikasi tambahan, membuka servis, 

Statistik Guides. 

10. Window  

Untuk pengaturan jendela SPSS seperti split File, Minimize 

all windows. 

11. Help 

Untuk bantuan informasi mengenai program SPSS seperti 

Topics, Tutorial, Statistic Coach. 

 

B. Pengenalan Halaman Kerja 

Halaman kerja pada program SPSS terdiri dari 2 bagian yaitu 

variabel view dan data view. Variebel view sebagai berikut : 

Variabel View Memasukkan dan mendefinisikan 
variabel 

Name Memberikan nama data 

Type Menentukan tipe data 

Width Menentukan Lebar Kolom 

Decimals Memberikan nilai desimal 

Label Memberi nama variabel 

Values Memberikan koding pada data nominal 
atau ordinal 

Missing Menentukan data yang hilang 

Columns Menentukan lebar kolom 

Align Menentukan rata kanan, kiri atau tengah 

Measure Menentuka skala pengukuran data (Scale, 
nominal atau ordinal 
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ersiapan data merupakan langkah awal yang penting, sebelum 

menganalisis data, dua poin yang paling mendasar dalam 

persiapan data yaitu mendefinisikan variabel dan input data. 

Proses pembuatan variabel dilakukan pada variabel view. 

 

A. Mendefinisikan Variabel 

Langkah-langkah dalam membuat variabel yaitu : 

Klik 2 kali pada aplikasi SPSS, kemudian akan muncul pada 

gambar dibawah ini : 

 

 

 

 

 

 

 

 

 

 

 

1. Header name disi berdasarkan nama singkat variabel tersebut. 

2. Header type disi dengan cara meng klik numeric agar dapat 

dianalisis. 

3. Header Widht dipergunakan untuk menentukan berapa digit 

atau karakter data yang akan dimasukkan. 

4. Header Decimals dipergunakan untuk mengisi jumlah angka 

decimal yang diinginkan (jumlah angka dibelakang koma). 

P 
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5. Header label dipergunakan untuk memberikan keterangan 

nama variabel tersebut, seperti gambar dibawah ini : 

 
6. Header values dipergunakan untuk memberi penjelasan nilai-

nilai individual dengan label sesuai keinginan (pemberian 

koding pada variabel).  

7. Header measure dipergunakan untuk menentukan skala data 

dari variabel tersebut. Secara teori skala data terdiri dari 

empat macam yaitu skala nominal, ordinal, interval dan rasio 

(Scale). Skala nominal adalah skala pengukuran yang paling 

lemah tingkatannya terjadi apabila bilangan atau lambing-

lambang lain digunakan untuk mengklasifikasikan objek 

pengamatan, biasanya terdiri dari dua kategori atau disebut 

dikotomi. Skala Ordinal adalah skala pengukuran yang 

membagi objek menjadi kelompok yang tidak tumpang 

tindih dan antara kelompok itu menyatakan adanya rangking 

atau tingkatan, kelompok ini dapat ditulis kurang dari (<) 

atau lebih dari (>) (Hastono dan Sabri, 2013). Skala interval 

adalah skala pengukuran yang menunjukkan jarak antara satu 

data dengan data yang lain dan mempunyai bobot yang sama 

sedangkan skala ratio adalah skala pengukuran yang 
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mempunyai nilai nol mutlak dan mempunyai jarak yang sama 

(Riduwan, 2009). 

Secara singkat dapat dilihat pada tabel dibawah ini : 

Tahapan-tahapan membuat variabel data penelitian 

1. Membuat nama variabel 
(Name) 

1. Nama variabel diawali 
dengan huruf 

2. Nama variabel tidak boleh 
menggunakan titik atau spasi 

3. Nama variabel maksimum 8 
karakter 

4. Nama variabel tidak boleh 
sama dengan lainnya 

2. Mendefinisikan tipe 
variabel 
( Type) 

1. Numerik : data berbentuk 
angka 

2. String : data berbentuk huruf 
3. Dll 

3. Menentukan kolom 
isian (Width) 

Merupakan kolom isian untuk 
jumlah digit data yang akan 
dimasukkan 

3. Mendefinisikan adanya 
decimal (Decimals) 

SPSS secara standar memberikan 
dua angka decimal untuk setiap 
data yang akan dientry,oleh karena 
itu untuk data yang tidak ada 
decimal diberi angka nol 

4. Memberikan Label 
(Labels) 

Menuliskan nama lengkap variabel 

5. Memberikan value  
(Values) 
 

Memberikan keterangan untuk 
setiap kode yang ada dalam kode 
tersebut. 

6. Menentukan lebar 
kolom (Column Width) 

Memberikan keterangan panjang 
karakter pada tiap variabel 

7. Menentukan posisi 
variabel (Aligment) 

Memberikan pilihan variabel dalam 
tabel, misalnya rata kanan, kiri atau 
tengah 
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B. Input Data 

Inputlah data berdasarkan data yang telah didapatkan pada saat 

dilapangan menggunakan instrument berupa kuesioner ataupun 

lembar observasi, dimana data yang didapatkan berupa skoring 

atau koding, penginputan datanya dengan cara Klik pada Data 

View, maka dapat dilihat seperti gambar dibawah ini : 
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A. Sorting Data 

Sorting adalah perintah yang digunakan untuk melakukan 

pengurutan data. Ada dua jenis pengurutan data yaitu 

pengurutan secara ascending (kecil ke besar) dan descending 

(besar ke kecil). 

 Langkah-Langkah sorting data adalah sebagai berikut : 

1. Buka program aplikasi computer SPSS 

2. Buka data yang ingin dilakukan pengurutan, kemudian Klik 

Data►Sort Cases, maka tampil sebagai berikut : 
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3. Kemudian Pindahkan dengan Klik Variabel Name►Sort 

by,maka akan terlihat nama responden tersebut berurutan 

berdasarkan abjad, seperti tampilan gambar dibawah ini : 

 

 

 

 

 

 

 

 

 

 

 

B. Select Case 

Select Case digunakan untuk melakukan filter/saringan/seleksi 

terhadap data kasus. Perintah Select Case ini akan menyeleksi file 

kasus berdasarkan kriteria tertentu yang diinginkan. 

 Langkah-Langkah Select Case data adalah sebagai berikut : 

1. Buka program aplikasi computer SPSS 

2. Buka data yang ingin dilakukan seleksi atau filter, kemudian 

Klik Data►Select Cases, maka tampil sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

 



 

10 
 

 

 

 

 

   

 

 

 

  

 

 

 

3. Kemudian Klik variabel yang mau di filter (Variabel Panjang 

Badan Balita sebagai contoh), Selanjutnya klik tanda panah 

agar masuk dalam Use Filter Variable (jika seleksi 

berdasarkan variabel tertentu), dan Klik OK, maka akan 

terlihat hasil filternya berupa garis, seperti tampilan gambar 

sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

 

 

dengan ketentuan : 

 All Cases : jika seleksi untuk seluruh kasus 

 If Condition is satiffied : jika seleksi berdasarkan kriteria 

tertentu. 
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 Random sample of cases : Jika seleksi berdasarkan bilangan 

acak. 

 Based on time or case range : jika seleksi berdasarkan range 

tertentu. 

 Use filter variable : jika seleksi berdasarkan variabel tertentu. 

 
 

 

 

 

 

 

 

 

 

 

 

 

4. Kemudian, silahkan Klik Analyze►Descriptive 

Statistics►Frequencies, kemudian masukkan variabel 

tersebut (variabel panjang badan balita) kedalam kotak 

Variable(s), dan Klik OK, maka akan tampil sebagai berikut :  
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5. Bisa dilihat pada table frequencies yaitu data valid berjumlah 

88 sampel, maka sampel yang berjumlah sebanyak 92 sampel, 

terseleksi menjadi 88 sampel, karena ada 4 sampel yang 

datanya kosong (missing data) untuk data panjang balita, oleh 

sebab itu yang terbaca hanya 88 sampel. 

C. Menambah Data, Menyisipkan Data dan Menghapus Data  

 Langkah-Langkah dalam menambah data adalah sebagai berikut 

: 

1. Buka program aplikasi computer SPSS pada data yang sudah 

di input. 

2. Klik Data View►baris kosong pada nomor 

respoden►Klik Kanan►Insert Cases,  maka tampil 

sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

 

 

 Langkah-Langkah dalam menyisipkan data adalah sebagai 

berikut : 

1. Buka program aplikasi computer SPSS pada data yang sudah 

di input. 

2. Klik Data View►baris yang disisipkan ►Klik 

Kanan►Insert Cases,  maka akan tampil baris kosong 

diatasnya, maka akan tampil seperti gambar sebagai berikut : 
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 Langkah-Langkah dalam menghapus data adalah sebagai berikut 

: 

1. Buka program aplikasi computer SPSS pada data yang sudah 

di input. 

2. Klik Data View►baris yang ingin dihapus ►Klik 

Kanan►Insert Clear,  maka akan tampil seperti gambar 

dibawah ini : 

 
 

 

 

 

 

 

 

 

 

 

D. Menambah Variabel, Menyisipkan Variabel dan Menghapus 

Variabel  

 Langkah-Langkah dalam menambah data adalah sebagai berikut 

: 
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1. Buka program aplikasi computer SPSS pada data yang sudah 

di input. 

2. Klik Variabel View►Klik baris kosong►Klik 

Kanan►Insert Variable,  maka tampil sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Kemudian lakukan pendefinisian variabel, sesua materi 

sebelumnya pada pada BAB II mengenai mendefinisikan 

Variabel sesuai dengan ketentuan yang terdapat Definisi 

Operasional. 

4. Selanjutnya untuk menyisipkan variabel dan menghapus 

variabel, sama seperti dengan cara menyisipkan data dan dan 

menghapus data, akan tetapi dilakukan pada Variable View. 

 



15 
 

E. Membuka Data SPSS dari Aplikasi lain 

Agar memudahkan dalam proses input data ke Program SPSS, 

pastikan semua data kuesioner, sudah terekapitulasi dalam bentuk 

program Microsoft Exel, kemudian data yang direkap harus dalam 

bentuk numeric atau angka berupa koding ataupun skoring, 

tergantung dari variabel tersebut, karena hanya data numeric atau 

angka berupa koding ataupun skoring yang dapat ter copy paste 

kedalam program SPSS. Seperti tampilan gambar dibawah ini : 

 

 

 

 

 

 

 

 

 

 

 Langkah-Langkah dalam membuka data dalam Program SPSS 

dari aplikasi Program Exel adalah sebagai berikut : 

1. Buka program aplikasi computer SPSS 

2. Klik File ►Open►Data,  maka tampil sebagai berikut : 
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3. Kemudian pilih File rekapitulasi hasil penelitian yang 

sudah diolah dan pastikan pilih Files of Type berupa 

(Exel, *.xls, *xlsx, *xlsm)►Klik Open (kemudian 

centang pada Read Variable names from the first row 

of data) yang digunakan apabila ingin langsung 

menggunakan baris header pada file exel diambil sebagai 

nama variabel pada program SPSS, dan Klik OK, maka 

tampil sebagai berikut : 
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4. Kemudian selanjutnya, variabel yang sudah masuk dalam 

Program SPSS, perlu dirapikan dan disesuaikan dengan 

Definisi Operasional yang sudah ditetapkan. 
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RANSFORMASI DATA adalah merubah dari jenis data 

yang mempunyai skala interval ke skala ordinal (kategorisasi 

atau transformasi digunakan untuk melakukan modifikasi 

terhadap nilai-nilai yang telah ada menjadi nilai baru didalam variabel 

yang baru juga. Transformasi data merupakan suatu bagian yang 

penting sebelum melakukan analisis data, apabila salah satu syarat uji 

statistik tersebut adalah mensyaratkan data kategori. 

A. Transformasi Compute 

Transformasi compute digunakan untuk menciptakan variabel  

baru atau memodifikasi nilai-nilai variabel setiap case. 

Transformasi ini khusus digunakan untuk tipe data numeric. 

Kasus data pengetahuan : 

Pertanyaan 

No. P1 P2 P3 P4 P5 P6 P7 P8 P9 P10 

1. 1 1 1 1 1 1 1 1 1 1 

2. 1 1 1 1 1 1 1 1 0 0 

3. 1 1 1 1 1 1 0 0 0 0 

4. 1 1 1 1 1 1 1 0 0 0 

5. 1 1 1 1 1 0 0 0 0 0 

6. 1 1 1 1 0 0 0 0 0 0 

7. 1 1 1 1 1 1 1 1 0 0 

8. 1 1 1 1 1 1 0 1 0 1 

9. 1 1 1 1 1 1 0 1 1 0 

10. 1 1 1 0 0 0 1 1 1 1 

11. 1 1 1 0 0 1 1 0 0 0 

12. 1 1 1 1 1 1 1 1 1 1 

13. 1 1 1 1 1 1 1 1 0 0 

T 
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14. 1 1 1 1 1 1 0 0 0 0 

15. 1 1 1 1 1 1 1 0 0 0 

16. 1 1 1 1 1 0 0 0 0 0 

17. 1 1 1 1 0 0 0 0 0 0 

18. 1 1 1 1 1 1 1 1 0 0 

19. 1 1 1 1 1 1 0 1 0 1 

20. 1 1 1 1 1 1 0 1 1 0 

21. 1 1 1 0 0 0 1 1 1 1 

22. 1 1 1 0 0 1 1 0 0 0 

23. 1 1 1 1 1 1 1 1 1 1 

24. 1 1 1 1 1 1 1 1 0 0 

25. 1 1 1 1 1 1 0 0 0 0 

26. 1 1 1 1 1 1 1 0 0 0 

27. 1 1 1 1 1 0 0 0 0 0 

28. 1 1 1 1 0 0 0 0 0 0 

29. 1 1 1 1 1 1 1 1 0 0 

30. 1 1 1 1 1 1 0 1 0 1 

31. 1 1 1 1 1 1 0 1 1 0 

32. 1 1 1 0 0 0 1 1 1 1 

33. 1 1 1 0 0 1 1 0 0 0 

34. 1 1 1 1 1 1 1 1 1 1 

35. 1 1 1 1 1 1 1 1 0 0 

36. 1 1 1 1 1 1 0 0 0 0 

37. 1 1 1 1 1 1 1 0 0 0 

38. 1 1 1 1 1 0 0 0 0 0 

39. 1 1 1 1 0 0 0 0 0 0 

40. 1 1 1 1 1 1 1 1 0 0 
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 Langkah-Langkah dalam penginputan adalah sebagai berikut : 

1. Buka program aplikasi computer SPSS 

2. Klik variabel view untuk membuat nama variabel dari P1 

sampai P10 

3. Pilihlah numeric pada kotak type untuk keperluan analisis 

4. Isian pada kotak width tetap dibiarkan 8  

5. Pilih lah angka 0 pada kotak decimal 

6. Untuk kotak lainya dibiarkan saja, maka akan tampil seperti 

gambar dibawah ini : 

  

  

 

 

 

 

  

 

 

 

 

7. Setelah itu Klik Data View untuk pengisian data mentah dari 

kuesioner ke Data View, maka hasilnya sebagai berikut : 
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8. Kemudian Klik Transform►Compute, maka akan tampil 

seperti gambar dibawah ini : 

 

 

 

 

 

 

 

 

 

 

 

9. Kemudian tuliskan nama variabel singkat pada Target 

Variabel dan Klik Type & Label untuk nama variabel 

selengkapnya, maka akan tampil seperti gambar dibawah ini  

 

 

 

 

 

 

 

 

 

 

 

10. Setelah itu,  masukkan variabel pertanyaan pertama sampai 

pertanyaan kesepuluh ke dalam kotak Numerix Expression 

dengan cara menjumlahkan setiap variabel pertanyaan dan 

Klik OK, maka akan tampil seperti gambar dibawah ini : 
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11. Setelah itu,  klik pada Data View, maka akan terlihat variabel 

baru yang bernama variabel Skor, dimana nama variabel 

tersebut diisi pada kotak Target Variabel, kemudian 

pastikan bilangan angkanya adalah bilangan bulat, karena 

skor pengetahuan yang telah didapatkan di lapangan berupa 

data numerik bilangan bulat, dengan cara Klik Variabel 

View, kemudian klik bagian decimal dengan 

memberikan angka 0. Seperti gambar dibawah ini : 

   

 

 

 

 

 

 

 

 

 

 

B. Transformasi Recode (skala interval ke skala ordinal 

(kategorisasi) 

1. Kategorisasi 

Kategorisasi bertujuan untuk mengelompokkan data yang 

semua dalam bentuk angka-angka ke dalam bentuk kata 

dengan skala ordinal atau nominal. Terdapat beberapa 

kategorisasi yang umum digunakan dalam penelitian yaitu 

kategori 3, kategori 4 dan kategori 5 

 Kategori 3 : secara statistik kategori 3 dapat dituliskan rumus 

sebagai berikut . 

[Tinggi : X ≥ M + SD] 

[Sedang : M – SD ≤ X < M + SD] 
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[Rendah : X ≤ M – SD] 

 Kategori 4 : kategori 4 yang umum digunakan dengan rumus 

statistik sebagai berikut. 

[Sangat Tinggi : X ≥ M + 1,5 SD] 

[Tinggi  : M ≤ X < M + 1,5 SD] 

[Rendah  : M-1,5 SD ≤ X < M] 

[Sangat Rendah : M-1,5 SD ≥ X] 

 Kategori 5 : kategori 5 yang umum digunakan dengan rumus 

statistik sebagai berikut. 

[Sangat Tinggi : X ≥ M + 1,5 SD] 

[Tinggi  : M + 0,5 SD ≤ X < M + 1,5 SD] 

[Sedang  : M – 0,5 SD ≤ X < M – 0,5 SD] 

[Rendah  : M-1,5 SD ≤ X < M – 0,5 SD] 

[Sangat Rendah : X ≤ M – 1,5 SD] 

Keterangan :  

X : Skor 

M : Mean 

SD : Standar Deviasi 

 

Contoh Kasus :  

Kasus penelitan mengenai hubungan pengetahuan dengan 

kejadian anemia ibu hamil di Puskesmas X berdasarkan “Definisi 

Operasional Penelitian yang telah ditetapkan” dengan data 

sebagai berikut :  

 Langkah-Langkah dalam penginputan adalah sebagai berikut : 

1. Buka program aplikasi computer SPSS yang datanya sudah di 

input dan sudah dilakukan proses compute variabel. 

2. Kemudian Klik Transform►Recode Into Different 

Variabels, maka akan tampil seperti gambar dibawah ini : 
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3. Kemudian Klik Variabel Skor Pengetahuan, kemudian 

masukan ke dalam kotak Numeric Variabel-Output Variabel, 

Setelah itu berikan nama variabel sesingkat mungkin untuk 

diketik Bagian Name dan ketikkan nama variabel selengkapnya 

pada Bagian Label dan Kemudian Klik Change dan Klik Old 

and New Values, maka akan tampil seperti gambar dibawah ini 

: 
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3. Setelah itu, Klik Range, value through Highest 

(Masukkan Batasan Skor Untuk keterangan lebih dari, 

sedangkan Range, Lowest through value (Masukkan 

batasan skor untuk keterangan kurang dari►Klik Value 

(untuk koding sesuai Defnisi Operasional yang telah 

ditetapkan), kemudian Klik Continue dan Klik OK, maka 

akan tampil seperti gambar dibawah ini : 

 

 

 

 

 

 

 

 

 

 

 

4. Kemudian, Klik Variabel View, setelah itu, Klik Values 

(Pengkodingan), maka tampilannya sebagai berikut : 
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5. Kemudian, Klik Data View, untuk melihat hasil dari 

pengkodingan, maka tampilannya sebagai berikut : 

 

 

 

C. Transformasi Count 

Transformasi Count digunakan bertujuan untuk menghitung 

berapa kali kemunculan data yang sama pada sebuah deret nilai 

serta dapat juga memberikan kriteria pada nilai-nilai yang akan di 

kenai proses Count. 
 Langkah-Langkah dalam Count adalah sebagai berikut : 

1. Buka program aplikasi computer SPSS, yang datanya sudah 

di input. 

2. Kemudian Klik Transform►Count values witihin cases, 

maka akan tampil seperti gambar dibawah ini : 
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3. Kemudian ketikkan pada Target Variable untuk 

membuat variabel baru►ketikkan pada Target Label 

untuk memberikan nama lengkap dari variabel baru 

tersebut►masukkan variabel skor pengetahuan pada 

numeric variables untuk mendaftar variabel atau untuk 

melihat skor yang sering muncul pada variabel skor 

pengetahuan, maka akan tampil seperti gambar dibawah 

ini : 

 

 

 

 

 

 

4. Kemudian ketikkan pada Define Values di isi sesuai 

dengan beberapa pilihan yaitu : 

 Value Individu  : digunakan untuk menghitung 

cacah nilai yang sama harganya dengan harga yang 

didefinisikan sebelumnya. 

 System Missing  : digunakan untuk menghitung 

cacah nilai yang merupakan system missing value. 

 System or Using Missing : digunakan untuk 

menghitung cacah nilai yang berharga missing. 

 Range dengan interval : digunakan untuk 

menghitung cacah nilai yang bernilai lebih besar atau 

sama dengan awal interval dan lebih kecil atau sama 

dengan akhir interval. 
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 Range, Lowest through value : digunakan untuk 

menghitung cacah nilai yang bernilai lebih kecil  atau 

sama dengan nilai yang didefinisikan. 

 Range, value through Highest : digunakan untuk 

menghitung  cacah nilai yang bernilai lebih kecil atau 

sama dengan nilai yang telah didefinisikan. 

 

 

 

 

 

 

 

 

 

 

 

5. Kemudian sebagai contoh, ingin melihat sering munculnya 

skor 0 sampai 5 yaitu dengan memasukkan skor 0 dan skor 5 

pada range interval ►Klik Add untuk dimasukkan di dalam 

kotak Values to Count►Klik Continue dan Klik OK, 

maka akan tampil seperti gambar dibawah ini : 
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6. Kemudian untuk merubah koding dari variabel baru 

tersebut, yaitu dengan Klik Variable View►Klik 

Values►Kemudian ketikkan pada Value koding “1” 

sedangkan pada Label diketikkan nama kategorinya yaitu 

skor 0 sampai 5 (sebagai contoh) untuk melihat skor 

yang sering muncul pada rentang skor 0 sampai skor 5, 

dan Klik OK, kemudian akan terlihat kategori skor 

tersebut (melihat frekuensi kemunculan), maka akan 

tampil seperti gambar dibawah ini : 

 

 

 

 

 

 

 

 

 

 

 

D. Transformasi Rank Cases 

Transformasi Rank Cases digunakan untuk menghitung dan 

menyusun rangking dari suatu deretan data. Dari hasil 

Transformasi Rank Cases ini akan menghasilkan variabel baru 

yaitu variabel rangking dari data tersebut. 

 Langkah-Langkah dalam Rank Cases adalah sebagai berikut : 

1. Buka program aplikasi computer SPSS, yang datanya 

sudah di input. 

2. Kemudian Klik Transform►Rank Cases, maka akan 

tampil seperti gambar dibawah ini : 
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3. Kemudian masukkan variabel skor pengetahuan dengan 

cara Klik Variabel Skor dan masukkan ke dalam kotak 

Variable(s)►Klik OK, dengan ketentuan : 

 Pada Rank Types, pastikan tercentang pada Rank 

 Pada Assign Rank 1 to ada dua pilihan yaitu : 

 Smallest Value : untuk menyusun rangking 

dengan ketentuan bahwa harga rank pertama  
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adalah harga rank dengan value terkecil dari 

variabel yang di daftar. 

 Largest Value  : untuk menyusun rangking 

dengan ketentuan bahwa harga rank pertama 

adalah harga rank dengan value terbesar dari 

variabel yang didaftar. 
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ENURUT Sugiyono (2006) statistik deskriptif adalah 

statistik yang berfungsi untuk mendeskripsikan atau 

memberikan gambaran terhadap obyek yang diteliti melalui 

data sampel atau populasi sebagaimana adanya, tanpa melakukan 

analisis dan membuat kesimpulan yang berlaku untuk umum. 

Berdasarkan Sutrisno Hadi (2004) dalam Riyanto (2013) menyatakan 

bahwa dalam perkembangan untuk menyelesaikan suatu masalah 

dapat digunakan beberapa pendekatan antara lain statistik dalam arti 

sempit dan statistik dalam arti luas. Statistik dalam arti sempit 

(Statistik Deskriptif) ialah statistik yang mendeskripsikan atau 

menggambarkan tentang data yang disajikan dalam bentuk tabel, 

diagram, pengukuran tedensi sentral, rata-rata hitung, rata-rata ukur, 

dan rata-rata harmonic, pengukuran penempatan (median,kuartil, 

desil dan persentil), pengukuran penyimpangan (range, rentangan 

antar kuartil. Rentangan semi antar kuartil, simpangan rata-rata, 

simpangan baku, varians, koefisien varians dan angka baku. 

 

 

 

 

 

 

 

Kegunaan statistik pada dasarnya terbagi menjadi enam Bagian 

yaitu : 

M 

STATISTIK 

Inferensial 

Deskriptif 

Nonparametrik 

Parametrik 
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1. Deskripsi (penggambaran) : menggambarkan data, misalnya 

gambaran angka kelahiran, angka kesakitan, angka kematian ibu 

melahirkan dan lain sebagainya. 

2. Komparasi : membandingkan data satu dengan lainnya. 

3. Korelasi : untuk mengetahui kuatnya hubungan data dari 

variabel satu dengan data variabel yang lain. 

4. Regresi (Kecenderungan) : meramalkan pengaruh data dari 

variabel yang satu dengan data dari variabel lainnya atau melihat 

perkiraan yang akan datang dengan melihat kecenderungannya. 

5. Mengambil keputususan : dengan melihat hasul perhitungan 

statistik atau fakta yang diperoleh dari analisis data, maka dapat 

diambil keputusan. 

6. Informasi : sebagai bahan informasi dalam bentuk data 

sekunder terhadap orang lain yang membutuhkan. 

 

A. Analisis Frequencies 

Prosedur Frequencies memiliki kegunaan pokok untuk 

melakukan pengecekan terhadap input data. Apakah data sudah 

diinputkan dengan benar. Hal ini mengingat bahwa dengan 

statistik frekuensi kita bisa mengetahui resume data secara 

umum, seperti misalnya berapa jumlah responden laki-laki, 

berapa jumlah responden perempuan dan sebagainya. Selain itu 

prosedur Frequencies juga memiliki kegunaan lain yaitu untuk 

menyediakan informasi deskripsi data yang menggambarkan 

demografi karakteristik dari sampel yang diambil (Wahyono, 

2012). 

Contoh Kasus :  

Kasus penelitan mengenai hubungan pengetahuan dengan 

kejadian anemia ibu hamil di Puskesmas X berdasarkan “Definisi 

Operasional Penelitian” dengan data sebagai berikut :  

 Langkah-Langkah dalam penginputan adalah sebagai berikut : 
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1. Buka program aplikasi computer SPSS yang datanya sudah di 

input dan sudah dilakukan proses compute variabel serta 

sudah dilakukan Transform recode into different variabels. 

2. Kemudian, Klik Analyze►Descriptive 

Statistics►Frequencies, maka akan tampil sebagai berikut 

:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Kemudian, Pindahan Variabel kategori pengetahuan 

kedalam kotak Variable(s), setelah itu Klik OK. maka akan 

tampil sebagai berikut :  
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Catatan :  

 Klik Statistics : Menampilkan Percentile Values, Central 

Tedency, Dispersion, dan Distribution. 

 Klik Charts : Menampilkan Chart Type seperti Bar 

Charts, Pie Charts, Histograms. 

 

 



37 
 

B. Analisis Descriptives 

1. Klik Analyze►Descriptive Statistics►Descriptives, 

maka akan tampil sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Kemudian, Pindahan Variabel Skor Pengetahuan kedalam 

kotak Variable(s), setelah itu Klik OK. maka akan tampil 

sebagai berikut :  
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Catatan :  

 Klik Options :  

1. Mean : Menunjukkan rata-rata skor dari variabel 

tersebut. 

2. Sum : Penjumlahan dari seluruh skor responden. 

3. Standar Deviasi : Menunjukkan disperse rata-rata dari 

sampel 

4. Maximum : Menunjukkan nilai tertinggi dari suatu 

deretan data. 

5. Minimum : Menunjukkan nilai terendah dari suatu 

deretan data. 

6. Kurtosis dan Skewness : digunakan untuk melakukan 

pengecekan data, apakah terdistribusi data normal atau 

terdistribusi data tidak normal. 

7. Kotal Display Order : Menunjukkan kriteria 

pengurutan data. Pengurutan data bisa dilakukan 

berdasarkan variabel, rata-rata nilai atau alphabetic. 

C. Analisis Explore 

Analisis eksplorasi (Explore) digunakan untuk menggambarkan 

tentang statistik  data yang lebih mendalam dan juga untuk 

melakukan uji normalitas dengan uji Liliefors. 

1. Klik Analyze►Descriptive Statistics►Explore, maka 

akan tampil sebagai berikut : 
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2. Kemudian pindahkan variabel Skor Pengetahuan kedalam 

kotak Dependen List dan Klik OK, maka akan tampil 

sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Keterangan :  

 Kotak Statistics : untuk melakukan perhitungan statistik-

statistik dasar. 

 Plots  : tombol untuk membuat visualisasi grafik 

dari analisis. 
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 Options : digunakan untuk memanajemen missing 

case atau data yang tidak tercatat. 

D. Analisis Crosstabs 

Analisa dengan prosedur Crosstabs merupakan analisa 

yang masuk dalam kategori statistik deskripsi, dimana 

menampilkan tabulasi silang atau tabel kontingensi yang 

menunjukkan suatu distribusi bersama dan pengujian hubungan 

antara dua variabel atau lebih. 

Analisis Crosstabs atau tabel silang digunakan untuk 

mengetahui hubungan antara baris dan kolom. Variabel baris 

adalah variabel independen sedangkan variabel kolom adalah 

variabel dependen serta data yang digunakan berskala nominal 

atau bisa juga berskala ordinal. 

Contoh Kasus :  

Kasus penelitan mengenai hubungan tingkat pendidikan dengan 

kejadian anemia ibu hamil di Puskesmas X berdasarkan “Definisi 

Operasional Penelitian” dengan data sebagai berikut : 

No. Tingkat Pendidikan Status 
Pekerjaan 

Kejadian 
Anemia 

1. Akademi/PerguruanTinggi Tidak Bekerja Tidak Anemia 

2. Akademi/Perguruan Tinggi Tidak Bekerja Tidak Anemia 

3. SLTA/Sederajat Tidak Bekerja Anemia 

4. SLTP/Sederajat Tidak Bekerja Anemia 

5. Akademi/Perguruan Tinggi Tidak Bekerja Tidak Anemia 

6. SLTA/Sederajat Bekerja Anemia 

7. SLTA/Sederajat Tidak Bekerja Anemia 

8. SLTA/Sederajat Tidak Bekerja Anemia 

9. Akademi/Perguruan Tinggi Tidak Bekerja Anemia 

10. Tidak Tamat SD Tidak Bekerja Anemia 

11. Akademi/Perguruan Tinggi Tidak Bekerja Tidak Anemia 

12. Akademi/Perguruan Tinggi Tidak Bekerja Tidak Anemia 

13. SLTA/Sederajat Tidak Bekerja Tidak Anemia 
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14. SLTA/Sederajat Tidak Bekerja Tidak Anemia 

15. SLTA/Sederajat Tidak Bekerja Tidak Anemia 

16. SD/Sederajat Tidak Bekerja Tidak Anemia 

17. Tidak Tamat SD Tidak Bekerja Anemia 

18. Tidak Tamat SD Tidak Bekerja Anemia 

19. Tidak Tamat SD Tidak Bekerja Anemia 

20. SLTP/Sederajat Tidak Bekerja Anemia 

21. Tidak Tamat SD Bekerja Anemia 

22. Tidak Tamat SD Bekerja Tidak Anemia 

23. Tidak Tamat SD Bekerja Tidak Anemia 

24. SLTP/Sederajat Tidak Bekerja Anemia 

25. SD/Sederajat Tidak Bekerja Tidak Anemia 

26. SLTP/Sederajat Tidak Bekerja Tidak Anemia 

27. SLTP/Sederajat Tidak Bekerja Tidak Anemia 

28. SLTP/Sederajat Tidak Bekerja Tidak Anemia 

29. SLTP/Sederajat Tidak Bekerja Tidak Anemia 

30. SLTP/Sederajat Tidak Bekerja Tidak Anemia 

31. SLTP/Sederajat Tidak Bekerja Tidak Anemia 

32. SD/Sederajat Bekerja Anemia 

33. Tidak Tamat SD Bekerja Anemia 

34. Tidak Tamat SD Bekerja Anemia 

35. SLTA/Sederajat Tidak Bekerja Anemia 

36. SD/Sederajat Tidak Bekerja Anemia 

37. SD/Sederajat Tidak Bekerja Anemia 

38. SLTP/Sederajat Tidak Bekerja Anemia 

39. SD/Sederajat Bekerja Anemia 

40. SD/Sederajat Tidak Bekerja Anemia 

 

 Langkah-langkah dalam melakukan Analisis Crosstabs adalah 

sebagai berikut : 

1. Buka program SPSS, kemudian Input data tesebut berdasarkan 

tabel Definisi Operasional yang telah disepakati. 

2. Klik Analyze►Descriptive Statistics►Crosstabs, maka 

akan tampil sebagai berikut : 
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3. Klik Variabel Tingkat Pendidikan (Variabel Independen) 

►Row(s), sedangkan variabel kejadian anemia pada ibu hamil 

(variabel dependen) ►Column(s), maka akan tampil sebagai 

berikut : 

 

 

  

   

 

 

 

 

 

 

 

4. Setelah itu, Klik Cells► Klik atau beri centang Observed pada 

Counts, kemudian Klik atau beri centang pada Row, Column 

dan total pada Percentages agar nilai persentase muncul pada 

baris, kolom dan total, kemudian Klik Continue dan Klik OK. 

Maka akan tampil sebagai berikut : 
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Keterangan :  

 Kotak Statistics : bertujuan untuk menampilkan hasil 

beberapa uji statistik seperti uji Chi-Square. 

 Display Clustered bar charts: bertujuan untuk 

menampilkan diagram batang (Bar Chart). 
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UESIONER adalah serangkaian pertanyaan yang diajukan 

kepada responden guna mengumpulkan informasi dari 

responden mengenai objek yang sedang diteliti, baik 

berupa pendapat, tanggapan atau dirinya sendiri. Sebagai suatu 

instrument penelitian, maka pertanyaan-pertanyaan tersebut tidak 

boleh menyimpang dari arah yang akan dicapai oleh usulan proyek 

penelitian yang tercermin dalam rumusan hipotesis, dengan demikian 

daftar pertanyaan yang harus diajukan dengan taktis dan strategik, 

sehingga mampu menyaring informasi dari responden (Nasir, Muhith 

dan Ideputri, 2011). 

Instrumen penelitian merupakan alat bantu peneliti dalam 

pengumpulan data. Mutu Instrumen akan menentukan juga mutu 

daripada data yang dikumpulkan, sehingga tepatlah dikatakan bahwa 

hubungan instrument dengan data adalah sebagai jantungnya 

penelitian. Oleh karena itu, menyusun instrument untuk kegiatan 

penelitian merupakan langkah terpenting yang harus dipahami benar-

benar peneliti (Riduwan, 2009). 

Validitas didefinisikan sebagai ukuran seberapa cermat suatu 

test melakukan fungsi ukurnya. Test hanya dapat melakukan 

fungsinya dengan cermat kalau ada sesuatu yang diukurnya. Validitas 

adalah ukuran yang menunjukkan sejauh mana instrument pengukur 

mampu mengukur jarak suatu titik (Riwidikdo, 2012). Misalnya ingin 

seorang peneliti ingin meneliti pengetahuan kepala keluarga mengenai 

pencegahan Demam Berdarah Dengue (DBD), maka validitas 

kuesionernya adalah sejauh mana kuesioner tersebut mampu 

mengukur pengetahuan kepala keluarga mengenai pencegahan 

Demam Berdarah Dengue (DBD). 

K 
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Uji validitas item digunakan untuk mengukur ketepatan  

suatu item dalam kuesioner atau skala, apakah item-item pada 

kuesioner tersebut sudah tepat dalam mengukur apa yang ingin diukur. 

Metode pengukurannya terdiri dari metode Corrected Item-Total 

Correlation dan Metode korelasi Pearson (Priyatno, 2011). 

Tahapan yang harus dilakukan untuk melakukan pengujian 

validitas yaitu : 

1. Mendefiniskan secara operasional suatu konsep yang akan 

diukur. 

2. Melakukan uji coba kepada responden, minimal dilakukan 

terhadap 30 responden. 

3. Mempersiapkan tabel tabulasi jawaban 

4. Menghitung nilai korelasi antara masing-masing skor butiran 

jawaban dengan skor total dan butir jawaban (Riwidikdo, 2012). 

Setelah mengukur validitas, maka perlu mengukur reliabilitas 

data, uji reliabilitas adalah suatu indeks yang menunjukkan sejauh 

mana suatu alat ukur tersebut dapat dipercaya atau dapat diandalkan. 

Kuesioner dapat dikatakan reliable jika jawaban konsisten (Rahman, 

2015). Uji reliabilitas digunakan untuk mengetahui konsistensi alat 

ukur, apakah alat pengukur yang digunakan dapat diandalkan dan 

tetap konsisten  jika pengukuran tersebut diulang. Metode uji 

reliabilitas yang sering digunakan adalah Cronbach’s Alpha untuk 

menentukan instrument  reliable atau tidak, menggunakan batasan 

tertentu yaitu 0,6.   

A. Uji Validitas berdasarkan Metode Corrected Item-Total 

Correlation 

Contoh Kasus :  

Data dibawah ini merupakan skor kuesioner pengetahuan 

mengenai anemia pada ibu hamil yang didapatkan pada saat 

dilapangan sebagai berikut :  
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No. P1 P2 P3 P4 P5 P6 P7 P8 P9 P10 

1. 1 1 1 1 1 1 1 1 0 0 

2. 1 1 1 0 1 1 1 1 1 0 

3. 1 1 1 1 1 1 0 0 1 1 

4. 1 1 1 1 1 1 1 0 1 1 

5. 1 1 1 1 1 1 1 1 1 1 

6. 1 1 1 0 1 0 1 1 0 1 

7. 1 1 1 1 1 1 1 1 0 0 

8. 1 0 1 1 1 1 1 1 1 1 

9. 1 0 1 1 1 1 0 1 1 1 

10. 1 0 1 1 1 1 1 1 1 1 

11. 0 0 0 0 0 0 0 0 0 0 

12. 0 0 1 0 0 0 0 0 0 0 

13. 1 1 1 1 1 1 1 1 1 1 

14. 0 0 0 0 0 0 0 0 0 0 

15. 1 1 1 1 1 1 1 1 1 1 

 

 Langkah-Langkah dalam penginputan adalah sebagai berikut : 

1. Buka program aplikasi computer SPSS 

2. Klik variabel view untuk membuat nama variabel dari P1 

sampai P10 

3. Pilihlah numeric pada kotak type untuk keperluan analisis 

4. Isian pada kotak width tetap dibiarkan 8  

5. Pilih lah angka 0 pada kotak decimal 

6. Untuk kotak lainya dibiarkan saja, maka akan tampil seperti 

gambar dibawah ini : 
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7. Setelah itu Klik Data View untuk pengisian data mentah dari 

kuesioner yang sudah direkapitulasi/copy paste dari hasil 

rekapitulasi ke Data View (data numeric berupa skoring atau 

koding agar dapat tercopy paste dari program exel ke program 

SPSS), maka hasilnya akan tampil sebagai berikut : 

 

8. Kemudian Klik Analyze►Scale►Reliability►Analysis, 

maka akan tampil seperti gambar dibawah ini : 
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9. Kemudian masukkan semua pertanyaan/pernyataan kedalam 

kotak items setelah itu Klik kotak statistics setelah itu 

berilah centang pada kotak item, scale dan scale if item 

deleted selanjutnya Klik Continue Klik OK seperti gambar 

dibawah ini : 
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10. Maka hasil akhirnya seperti tampilan di bawah ini : 

 

 

Validitas kuesioner dilakukan dengan membandingkan antara 

nilai r hasil dengan r tabel, r hasil didapatkan pada kolom 

corrected item-Total Correlation sedangkan r tabel didapatkan 

dengan menggunakan tabel r yang terlampir dan menggunakan 

𝑑𝑓 = 𝑛 − 2 = 15 − 2 = 13  dengan tingkat kemaknaan 5%, 

maka didapat r tabel 0,514 pada tabel r dibawah ini : 

df 5% 1% df 5% 1% df 5% 1% 

1 0,997 1,000 19 0,433 0,549 80 0,217 0,283 

2 0,950 0,990 20 0,423 0,537 90 0,205 0,267 

3 0,878 0,959 21 0,413 0,526 100 0,195 0,254 

4 0,811 0,917 22 0,404 0,515 125 0,174 0,228 

5 0,754 0,874 23 0,396 0,505 150 0,159 0,208 

6 0,707 0,834 24 0,388 0,496 200 0,138 0,181 

7 0,666 0,798 25 0,381 0,487 300 0,113 0,148 

8 0,632 0,765 26 0,374 0,478 400 0,098 0,128 

r alpha 

r hasil 
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9 0,602 0,735 27 0,367 0,470 500 0,088 0,115 

10 0,576 0,708 28 0,361 0,463 1000 0,062 0,081 

11 0,553 0,684 29 0,355 0,456    

12 0,532 0,661 30 0,349 0,449    

13 0,514 0,641 35 0,325 0,418    

14 0,497 0,623 40 0,304 0,393    

15 0,482 0,606 45 0,288 0,372    

16 0,468 0,590 50 0,273 0,354    

17 0,456 0,575 60 0,250 0,325    

18 0,444 0,561 70 0,232 0,302    

11. Interpretasi Hasil pada tabel diatas adalah sebagai berikut : 

Berdasarkan hasil diatas terlihat bahwa dari 10 pertanyaan, 

terdapat 1 pertanyaan yang tidak valid yaitu pertanyaan 

nomor 2 dikarenakan nilai r hasilnya (0,488) < r tabel (0,514), 

sesuai dengan ketentuan yang ada, bahwa untuk pertanyaan 

nomor 2 dapat dibuang dari kuesioner atau pertanyaannya 

tetap dipakai dalam kuesioner dengan syarat perbaikan 

sedangkan semua pertanyaan reliable dikarenakan r alpha 

(0,922) > r tabel (0,514). 

 

B. Uji Validitas berdasarkan Metode Korelasi Pearson 

Metode uji validitas ini yaitu dengan cara 

mengkorelasikan masing-masing skor item dengan skor total 

item. Skor total item adalah penjumlahan dari keseluruhan item. 

Jika nilai korelasi  (r hitung) lebih besar dari r tabel maka item 

kuesioner tersebut dinyatakan valid, sebaliknya jika r hitung lebih 

kecil dari r tabel atau nilai korelasi negative, maka item tidak valid. 
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Berikut adalah langkah-langkah dalam melakukan uji validitas 

menggunakan metode korelasi pearson : 

1. Buka program aplikasi komputer SPSS 

2. Input semua pertanyaan seperti metode pertama 

3. Klik Analyze►Correlate►Bivariate,kemudian pindahkan 

semua variabel pertanyaan dan variabel skor kedalam kotak 

variables  

4. Centang Kotak Pearson dan Klik Two-tailed setelah itu Klik 

OK, maka tampil seperti gambar dibawah ini : 
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5. Interpretasi hasil pada tabel diatas adalah sebagai berikut : 

Berdasarkan tabel diatas bahwa semua pertanyaan 

dibandingkan dengan r tabel, dimana r tabel didapatkan 

dengan menggunakan tabel r yang terlampir dan 

menggunakan 𝑑𝑓 = 𝑛 − 2 = 15 − 2 = 13  dengan tingkat 

kemaknaan 5% dan uji dua sisi, maka didapat r tabel 0,514. 

Berdasarkan hasil uji validitas tersebut didapatkan bahwa 
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nilai korelasi dari semua pertanyaan mempunyai nilai > nilai 

r tabel (0,514), berarti semua pertanyaan dinyatakan valid. 
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TATISTIK Komparasi parametrik merupakan uji beda bila 

datanya berskala interval atau rasio dan memenuhi prasyarat 

analisisnya, yaitu data berdistribusi normal dan variansi datanya 

homogen. Normalitas data bertujuan untuk mengetahui apakah 

penyebaran data merata sesuai dengan kurva normal. Dasar kurva 

normal adalah nilai rata-rata dan simpangan baku. Homogenitas data 

bertujuan untuk mengetahui apakah datanya memiliki varians yang 

sama. Uji komparasi parametrik yang baik harus memilki variansi data 

yang sama (Syarifudin, 2010). 

Uji normalitas data adalah prasyarat pokok dalam analysis statistic, 

karena apabila data berdistribusi normal, maka statistic yang 

digunakan adalah statistic parametric sedangkan data yang tidak 

berdistribusi normal, maka statistic yang digunakan adalah statistic 

non parametric. Uji statistic yang sering digunakan dalam uji 

normalitas data ialah uji Kolmogorov Smirnov. Data dinyatakan 

berdistribusi normal jika Signifikasi > 0,05 (Priyatno, 2011). 

Penyajian data, bila distribusi data normal, maka dianjurkan 

menggunakan mean dan standar deviasi sedangkan bila distribusi 

tidak normal, maka dianjurkan menggunakan median dan minimum-

maksimum sebagai pasangan ukuran pemusatan dan penyebaran.  

Dua metode dalam menguji kenormalan data yaitu dengan 

metode deskriptif dan metode analisis, kedua metode tersebut dapat 

dilihat pada tabel dibawah ini : 

 

 

S 
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Deskriptif Parameter Kriteria batasan 
data normal 

Keterangan 

Koefisien varian Nilai koefisien 
varians < 30% 

𝑆𝐷

𝑀𝑒𝑎𝑛
𝑥100% 

Rasio skewness Nilai rasio 
skewness -2 SD 
s/d 2 

𝑆𝑘𝑒𝑤𝑛𝑒𝑠𝑠

𝑆𝐸 𝑆𝑘𝑒𝑤𝑛𝑒𝑠𝑠
 

Rasio kurtosis Nilai rasio 
kurtosis -2 s/d 2 

𝐾𝑢𝑟𝑡𝑜𝑠𝑖𝑠

𝑆𝐸 𝐾𝑢𝑟𝑡𝑜𝑠𝑖𝑠
 

Histogram  Simetris, tidak 
miring kiri 
maupun kanan, 
tidak terlalu 
tinggi atau terlalu 
rendah 

 

Box plot  Simetris, media 
tepat di tengah, 
tidak ada ourlier 
atau nilai ekstrim 

 

Normal Q-Q 
plots 

Data menyebar 
sekitar garis 

 

Detrended Q-Q 
plots 

Data menyebar 
sekitar garis pada 
nilai 0 

 

Analitis Kolmogorov-
Smirnov 

Nilai kemaknaan 
(p) > 0,05 

Sampel > 50 
responden 

Shapiro-Wilk Nilai kemaknaan 
(p) > 0,05 

Sampel ≤ 50  
responden 

(Sumber : Dahlan, 2013). 

 

Uji homogenitas digunakan sebagai uji prasyarat jika akan 

melakukan uji T sampel bebas dan uji varian satu jalan. Uji ini untuk 

mengetahui varian populasi data adalah sama atau tidak. Jika nilai 

signifikasi lebih dari 0,05, maka dikatakan bahwa varian dari dua atau 

lebih kelompok data adalah sama (Priyatno, 2011). 
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Uji linieritas merupakan uji prasyarat yang biasanya dilakukan 

jika akan melakukan analisis uji korelasi. Uji ini bertujuan untuk 

mengetahui apakah dua variabel secara signifikan mempunyai 

hubungan yang linier atau tidak. Uji linieritas pada SPSS digunakan 

Test for Liniarity dengan taraf signifikasi 0,05. Dua variabel dikatakan 

mempunyai hubungan yang linier bila signifikasi pada Liniarity kurang 

dari 0,05 (Priyatno, 2011). 

 

A. Uji Normalitas menggunakan Metode Analitis 

Kolmogorov-Smirnov versi pertama 

Contoh Kasus :  

Hubungan pengetahuan dengan kejadian anemia ibu hamil di 

Puskesmas X berdasarkan “Definisi Operasional Penelitian” 

dengan data sebagai berikut 

Data Kuesioner Pengetahuan : 

 

No. P1 P2 P3 P4 P5 P6 P7 P8 P9 P10 Skor 

1. 1 1 0 1 1 1 1 0 1 1 8 

2. 1 1 0 1 0 1 0 1 1 1 7 

3. 1 1 0 1 0 1 0 1 1 1 7 

4. 1 1 0 1 1 1 0 1 1 1 8 

5. 1 1 0 1 1 1 0 1 1 1 8 

6. 1 1 0 1 1 1 1 0 1 1 8 

7. 1 1 0 0 1 1 1 0 1 1 7 

8. 1 1 0 1 0 1 1 0 1 1 7 

9. 1 1 0 1 1 1 1 0 0 1 7 

10. 1 1 0 1 0 1 1 0 1 1 7 

11. 1 1 0 0 1 1 1 0 1 1 7 

12. 1 1 0 1 1 1 1 0 1 1 8 

13. 1 1 0 0 1 1 1 0 1 1 7 

14. 1 1 1 1 0 1 1 0 0 1 7 

15. 1 1 0 1 1 1 1 1 1 1 9 

16. 1 1 0 0 0 1 1 0 0 1 5 

17. 1 1 0 0 0 1 1 0 0 1 5 

18. 1 1 0 0 0 1 1 0 0 1 5 

19. 1 1 0 0 0 1 1 0 0 1 5 

20. 1 1 0 0 0 1 1 0 0 1 5 

21. 1 1 0 1 0 1 1 1 1 1 8 

22. 1 1 0 0 0 1 1 0 1 1 5 
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Berikut adalah langkah-langkah dalam melakukan uji validitas 

menggunakan metode Kolmogorov-Smirnov versi pertama:  

1. Buka program aplikasi komputer (SPSS). 

2. Input data diatas sesuai data tabel diatas. 

3. Klik Analyze►Nonparametrik Test►Legacy Dialogs, 

kemudian Klik►1-Sample K-S, maka akan tampil sebagai 

berikut : 

 

 

 

 

 

 

23. 1 1 0 0 0 1 1 0 0 1 5 

24. 1 1 0 0 0 1 1 0 0 1 5 

25. 1 1 0 1 0 1 1 0 1 1 7 

26. 1 1 0 0 0 1 1 0 0 1 5 

27. 1 1 0 0 0 1 1 0 1 1 5 

28. 1 1 0 0 0 1 1 0 1 1 5 

29. 1 1 0 0 0 1 1 0 0 1 4 

30. 1 1 0 1 1 1 0 0 1 1 7 

31. 1 1 0 1 1 1 0 0 1 1 6 

32. 1 1 0 1 1 1 0 0 1 1 6 

33. 1 1 0 1 0 1 1 0 1 1 6 

34. 1 1 0 0 1 1 1 0 0 1 5 

35. 1 1 0 1 0 1 1 0 0 1 5 

36. 1 1 0 1 0 1 1 0 0 1 5 

37. 1 1 0 1 0 1 1 0 0 1 5 

38. 1 1 0 1 0 1 1 0 0 1 5 

39. 1 1 1 1 0 1 1 0 1 1 8 

40. 1 1 0 1 0 1 1 0 0 1 5 

41. 1 1 0 1 0 1 1 0 0 1 5 

42. 1 1 0 1 0 1 1 0 0 1 5 

43. 1 1 0 1 0 1 1 0 0 1 5 

44. 1 1 0 1 0 1 1 0 1 1 7 

45. 1 1 0 1 0 1 1 1 0 1 7 

46. 1 1 0 1 1 1 1 0 1 1 8 

47. 1 1 0 1 0 1 1 1 1 1 8 

48. 1 1 1 1 0 1 1 0 1 1 8 

49. 1 1 1 1 0 1 1 0 1 1 8 

50. 1 1 0 1 1 1 1 0 1 1 8 
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4. Kemudian masukkan skor pengetahuan ke kotak Test Variable 

List seperti gambar dibawah ini : 
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5. Setelah itu klik OK, maka tampilan akhir seperti gambar dibawah 

ini :  

 

 

 

 

 

 

 

 

 

 

 

 

6. Interpretasi hasil output diatas ialah : 

Output diatas menunjukkan hasil analisis uji normalitas variabel 

pengetahuan dengan melihat Asymp.Sig (2-tailed) pada kolom 

yaitu p-value (0,002) < 0,05, artinya data tidak berdistribusi 

normal, maka uji statistic yang digunakan adalah statistic 

nonparametric. 
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B. Uji Normalitas menggunakan Metode Analitis 

Kolmogorov-Smirnov versi kedua 

1. Buka program aplikasi komputer (SPSS). 

2. Input data diatas sesuai data tabel diatas. 

3. Selanjutnya Klik Analyze ►Descriptive ►Explore, kemudian 

masukkan skor pengetahuan kedalam kotak Dependent List, 

maka tampilannya sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Selanjutnya Klik Kotak Plots►Klik Factor Levels Together 

pada Boxplots►Beri Centang Histogram pada Deksriptive            
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►Beri Centang pada Normality Plots With Test►Klik 

Continue, maka tampilannya sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

5. Interpretasi hasil output diatas ialah : 

Berdasarkan tabel diatas p-value 0,000 < 0,05, artinya secara 

statistic data tersebut tidak berdistribusi normal. 
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C. Transformasi Data untuk Menormalkan Data 

1. Klik Transform ►Compute 

2. Ketik tran_pengetahuan pada Target variable, kemudian 

Klik Arithmetic pada Function Group, selanjutnya Klik 

Log10/Lg10 pada Functions and Special Variables 

3. Selanjutnya Klik tanda panah dibawah, maka akan timbul 

LG10(?) pada Numeric Expression, kemudian masukkan 

variabel skor pengetahuan kedalam kotak Numeric 

Expression dengan Klik tanda panah yang ada di samping, 

dan Klik OK, maka akan tampil seperti gambar dibawah ini : 
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4. Selanjutnya lakukan lah uji normalitas untuk variabel 

tran_pengetahuan dengan langkah-langkah uji normalitas yang 

telah dibahas sebelumnya. 

D. Uji Homogenitas  

Homogenitas data bertujuan untuk mengetahui apakah datanya 

memiliki varians yang sama. Uji komparasi parametrik yang baik 

harus memilki variansi data yang sama (Syarifudin, 2010). Uji 

homogenitas kalau diartikan secara mudahnya adalah uji yang 

menilai adakah perbedaan varians antara kedua kelompok atau 

lebih. Oleh sebab itu, Uji homogenitas hanya digunakan atau 

prasyarat pada uji parametris yang menguji perbedaan antara 

kedua kelompok atau beberapa kelompok yang berbeda 

subjeknya atau sumber datanya. Oleh karena itu, uji 

homogenitas diperlukan sebagai asumsi dari uji independen t 

test dan uji Anova. 

Contoh Kasus :  

Apakah ada perbedaan pengetahuan terhadap penggunaan media 

Power Poin dan penggunaan media audio visual dalam penyuluhan di 

masyarakat, dengan data sebagai berikut : 

Data Kuesioner Pengetahuan : 

No. Media Penyuluhan 
Power Poin 

Media Penyuluhan Audio 
Visual 

1. 8 9 

2. 7 9 

3. 6 9 

4. 7 9 

5. 7 10 

6. 8 10 

7. 7 8 

8. 8 8 

9. 9 7 

10. 8 7 

11. 6 7 

12. 7 7 
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13. 7 8 

14. 7 8 

15. 8 8 

16. 7 9 

17. 7 9 

18. 7 8 

19. 8 9 

20. 7 8 

21. 7 9 

22. 8 10 

23. 8 10 

24. 8 7 

25. 8 7 

26. 7 8 

27. 9 7 

28. 7 8 

29. 7 7 

30. 8 7 

1. Buka program aplikasi komputer (SPSS). 

2. Input data diatas sesuai data tabel diatas. 

3. Selanjutnya Klik Analyze►Compare Means►Independent-

Samples T Test, kemudian masukkan skor pengetahuan 

kedalam kotak Dependent List, maka tampilannya sebagai 

berikut : 
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4. Selanjutnya Klik dan pindahkan variabel skor pengetahuan 

►Test Variable(s), sedangkan Klik dan pindahkan variabel 

kelompok media penyuluhan kedalam kotak Grouping 

Variable, setelah itu Klik Define Group dengan keterangan 

Group 1 [menyatakan Kelompok 1] dan Group 2 [menyatakan 

Kelompok 2] Setelah itu Klik OK. Maka tampilannya sebagai 

berikut : 

 

 

 

 

 

 

 

 

 

 

 

5. Interpretasi : Kesimpulan didapatkan berdasarkan nilai 

probabilitas, yaitu jika Probabilitas > α (0,05), Maka Ho 
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diterima, sedangkan jika Probabilitas < α (0,05), Maka Ho 

ditolak. Terlihat bahwa nilai probabilitas atau sig. (0,032) pada 

keterangan Levene’s Test for Equality of Variances. 

Berdasarkan hal tersebut bahwa nilai probabilitas (0,032) < α 

(0,05), Maka Ho ditolak yang berarti kedua varians adalah 

berbeda. 

E. Uji Linieritas 

Uji linieritas merupakan uji prasyarat yang biasanya dilakukan, 

jika akan melakukan analisis korelasi. Uji ini bertujuan untuk 

mengetahui apakah dua variabel secara signifikan mempunyai 

hubungan yang linier atau tidak, untuk uji ini pada SPSS 

menggunakan Test for Linearity dengan taraf signifikasi 0,05. 

Dua variabel dikatakan mempunyai hubungan yang linier, 

apabila nilai signifikasi pada Linearity < 0,05 (Priyatno, 2011). 

Uji ini biasanya digunakan sebagai prasyarat dalam analisis 

korelasi atau regresi linear.Pada tabel ANOVA kita bisa 

memverifikasi linearitas pada bagian linearity dan Deviation 

from linearity. Linearity ini menggambarkan apakah model 

linear dapat menjelaskan dengan baik hubungan antar variabel. 

Jika linearity signifikan (p<0,05), maka itu berarti hubungan 

antar variabel dapat dijelaskan menggunakan model linear. 

Deviation from linearity menunjukkan penyimpangan dari pola 

linear. Jika penyimpangan ini signifikan (sig < 0,05), itu artinya 

data kita tidak linear. Namun jika penyimpangan ini tidak 

signifikan (sig > 0,05), itu menunjukkan tidak ada perbedaan 

data kita dengan data linear ideal, dengan demikian kita dapat 

menyataka data kita linear. 
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Contoh Kasus :  

Apakah ada hubungan antara variabel kecemasan dengan tekanan 

darah, berdasarkan data dilapangan didapatkan data sebagai berikut : 

No. Kecemasan Tekanan Darah 

1. 70 130 

2. 80 120 

3. 90 160 

4. 70 130 

5. 60 120 

6. 60 130 

7. 50 120 

8. 50 120 

9. 70 130 

10. 80 140 

11. 90 150 

12. 70 130 

13. 60 120 

14. 80 140 

15. 90 150 

16. 70 130 

17. 60 120 

18. 60 140 

19. 50 130 

20. 50 120 

21. 80 130 

22. 90 150 

23. 70 140 

24. 80 130 

25. 90 120 

26. 70 130 

27. 60 120 

28. 80 140 

29. 90 160 

30. 70 130 
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1. Buka program aplikasi komputer (SPSS). 

2. Input data diatas sesuai data tabel diatas. 

3. Selanjutnya Klik Analyze►Compare Means►Means, maka 

tampilannya sebagai berikut : 

 

 

 

 

 

 

 

 

 
4. Kemudian Klik atau pindahkan variabel Tekanan 

Darah►Dependent List, dan Klik atau pindahkan variabel 

skor kecemasan ►Independent List, jika sudah Klik 

Options► Klik Centang  Test for Linearity►Klik 

Continue►Klik OK, maka tampilannya sebagai berikut : 
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Tentang Penulis  
Perkembangan teknologi dan informasi saat 

ini begitu pesat, bahkan dihadapkan dengan 

perkembangan era digital yaitu revolusi 

industri 4.0, dimana hampir semua kegiatan 

dihadapkan dengan penggunaan teknologi, 

tidak terlepas dari kegiatan dosen maupun 

mahasiswa, dimana kegiatan tersebut dalam 

rangka pengolahan dan analisis data 

penelitian. Buku ini hadir untuk dapat 

menjawab kesulitan bagi para dosen dan mahasiswa yang kesulitan 

dalam melakukan manajemen data hasil penelitian. Buku ini berjudul 

“Manajemen Data menggunakan SPSS” merupakan panduan 

dalam melakukan manajemen data yang berisi teknis dalam 

manajemen serta disertasi kasus penelitian kesehatan. 
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